
 

  

Infor LN Integration Guide for Infor 
LN Analytics Foundation 

LN 10.3 or later 
LN Analytics Foundation 10.4.1 or later 

 



  

  

Copyright © 2016 Infor  

 

Important Notices 

The material contained in this publication (including any supplementary information) constitutes and 

contains confidential and proprietary information of Infor. 

By gaining access to the attached, you acknowledge and agree that the material (including any 

modification, translation or adaptation of the material) and all copyright, trade secrets and all other 

right, title and interest therein, are the sole property of Infor and that you shall not gain right, title or 

interest in the material (including any modification, translation or adaptation of the material) by virtue 

of your review thereof other than the non-exclusive right to use the material solely in connection with 

and the furtherance of your license and use of software made available to your company from Infor 

pursuant to a separate agreement, the terms of which separate agreement shall govern your use of 

this material and all supplemental related materials ("Purpose"). 

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to 

maintain such material in strict confidence and that your use of such material is limited to the 

Purpose described above. Although Infor has taken due care to ensure that the material included in 

this publication is accurate and complete, Infor cannot warrant that the information contained in this 

publication is complete, does not contain typographical or other errors, or will meet your specific 

requirements. As such, Infor does not assume and hereby disclaims all liability, consequential or 

otherwise, for any loss or damage to any person or entity which is caused by or relates to errors or 

omissions in this publication (including any supplementary information), whether such errors or 

omissions result from negligence, accident or any other cause. 

Without limitation, U.S. export control laws and other applicable export and import laws govern your 

use of this material and you will neither export or re-export, directly or indirectly, this material nor any 

related materials or supplemental information in violation of such laws, or use such materials for any 

purpose prohibited by such laws. 

Trademark Acknowledgements 

The word and design marks set forth herein are trademarks and/or registered trademarks of Infor 

and/or related affiliates and subsidiaries. All rights reserved. All other company, product, trade or 

service names referenced may be registered trademarks or trademarks of their respective owners. 

Publication Information 

Release: Infor LN 10.3 or later and Infor LN Analytics Foundation 10.4.1 or later 

Publication date: July 6, 2016 

 



  

Infor LN Integration Guide for Infor LN Analytics Foundation | 3 

Contents 

About this guide ................................................................................................................................... 5 

Intended audience ........................................................................................................................... 5 

Required knowledge .................................................................................................................. 6 

Related documents .......................................................................................................................... 7 

Contacting Infor................................................................................................................................ 8 

Chapter 1 Requirements ................................................................................................................. 9 

Required products ........................................................................................................................... 9 

Chapter 2 Integration checklist .................................................................................................... 11 

Chapter 3 Overview ....................................................................................................................... 13 

Terminology ................................................................................................................................... 13 

Integration of solution components ................................................................................................ 13 

Data mapping ................................................................................................................................. 14 

Chapter 4 Configuring the products ............................................................................................ 15 

LN ................................................................................................................................................... 15 

ION ................................................................................................................................................. 15 

Business Vault ............................................................................................................................... 16 

Infor Analytics Foundation ............................................................................................................. 16 

Chapter 5 Publishing BODs .......................................................................................................... 17 

Starting products and services ...................................................................................................... 17 

Initial data load ............................................................................................................................... 17 

Publishing existing master data............................................................................................... 17 

Publishing transactional BODs ................................................................................................ 19 

Publishing any additional initialization data ................................................................................... 19 

 



Contents 

4 | Infor LN Integration Guide for Infor LN Analytics Foundation 

 



  

Infor LN Integration Guide for Infor LN Analytics Foundation | 5 

About this guide 

This document describes the integration of Infor LN and Infor LN Analytics Foundation. It explains 

the integration requirements, configuration tasks, and troubleshooting information. This document 

also describes how to publish Business Object Documents (BODs), load your data, and verify that 

the integration is set up correctly.  

Intended audience 
This guide is intended for the system administrator or consultant who will configure the integration 
between Infor LN and Infor LN Analytics Foundation. Before you read this guide, ensure that you are 
familiar with the other guides listed in “  
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Related documents.” 

Required knowledge 

To integrate Infor LN and Infor LN Analytics Foundation, you must have experience or knowledge in 

these areas: 

 Understand the concepts behind Infor ION and BODs, and how the concepts relate to each of 

the products in this integration. For more information, see these topics: 

 “Overview” section in Infor LN Configuration Guide for Infor ION 

 “Additional Business Vault BOD information” section in Infor Business Vault Administration 

Guide 
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Related documents 
This table shows the types of documents that are related to ION integrations and their purpose: 

Document type Purpose 

Infor LN Configuration Guide for Infor ION This guide provides configuration and 

implementation information for the BOD-

based integration of LN with ION when ION 

is used to exchange data with another Infor 

or third-party product. The document 

describes configuration requirements and 

provides setup instructions that are specific 

to LN. It provides information about the 

business events or user actions in LN that 

send the various BODs to ION Connect.  

Infor LN Outbound BOD Mapping and Descriptions For each BOD that the product has certified, 

this document provides the source and 

definition of the data in each BOD element 

that is sent from the product through ION. 

This document also provides details about 

the data that is published. 

Infor LN to Infor BDS Cross BOD Mapping and 

Descriptions 

This document provides end-to-end 

integrated BOD mapping details for BODs 

that are exchanged between this product 

and another product. It describes the 

exceptions and handling requirements by 

element. 

Infor LN Integration Guide for Infor ION Business 

Vault 

This document provides implementation 

information for the BOD integration between 

the product and Infor ION Business Vault  

for use by Infor Reporting and Infor 

Business Analytics. This guide describes the 

configuration requirements and provides 

setup instructions. It includes information 

about how to verify and troubleshoot the 

integration. 

lnfor Business Analytics Installation Guide This document provides installation and 

configuration information for the Infor LN 

Analytics Foundation. 

Infor Business Vault Administration Guide 

 

This document describes configuration 

information for Business Vault. 

Not all of these documents are required to set up this integration. For a list of documents that are 

required for this integration, see the integration checklist within this document. 
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Contacting Infor 
If you have questions about Infor products, go to the Infor Xtreme Support portal at 

www.infor.com/inforxtreme. 

If we update this document after the product release, we will post the new version on this website. 

We recommend that you check this website periodically for updated documentation.  

If you have comments about Infor documentation, contact documentation@infor.com. 

  

http://www.infor.com/inforxtreme
mailto:documentation@infor.com
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Chapter 1 Requirements 1  

 

 

Ensure that all requirements and prerequisites are met. 

Required products 
Ensure that you have installed and configured the necessary hardware and software for all of these 

components: 

 Infor ION Connect release 10.2 or later. The server where you install ION must be able to 

connect to the servers where you install Infor LN and Infor Business Vault. 

 Infor LN 10.3 or later 

 Infor LN Analytics Foundation 10.4.1 or later 

 Infor Business Vault, BDS, OLAP, BI Application studio, see the next table 

 

Foundation 

version 

BV version BDS version OLAP 

version 

BI version 

10.4.1 11.2 10.3.7  10.6 

10.4.2 11.3 10.4.4  11.0 

10.5.0 11.3 10.4.4 11.0.0.254 11.0.0.237 
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 Follow this checklist to integrate the products: 

Complete? Task Reference 

□  Collect the documents listed in the next 

column from Infor Xtreme. These documents 

are required for this integration. 

 Infor LN Configuration Guide for 

Infor ION 

 Infor LN Integration Guide for Infor 

ION Business Vault 

 Infor LN to Infor BDS Cross BOD 

Mapping and Descriptions 

□  Ensure that all requirements and prerequisites 

are met. 

“Requirements” on page 9 

□  Review the description of this integration. “Overview” on page 13 

 

□  Verify that the Infor LN instances you plan to use 

are connected to Infor ION. If they have not 

been configured, then configure the connection.  

“Configuring Infor LN” section in Infor 

LN Configuration Guide for Infor ION 

□  Verify that the Infor Business Vault instances 

you plan to use are connected to Infor ION. If 

they have not been configured, then configure 

the connection.  

“Business Vault integration and 

Infor LN settings” section in Infor 

LN Integration Guide for Infor ION 

Business Vault 

□  Perform additional configuration of Infor LN 

specific to this integration. 

 “Configuring the products” on page 

15 

□  Perform additional configuration of Infor 

Business Vault specific to this integration. 
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Terminology 
The terminology between Infor LN and Infor LN Analytics Foundation differs in some areas. To 

explain the process and communicate steps clearly, sometimes the BOD terminology is used. This 

table shows an overview of the Infor LN, Infor LN Analytics Foundation, and BOD terminology: 

Infor LN term 

Infor LN Analytics 

Foundation term BOD term 

Item Item ItemMaster 

Business partner Supplier/Customer SupplierPartyMaster/CustomerPartyMaster 

Unit Unit CodeDefinition (UOM) 

See the appropriate configuration guide for Infor ION to review definitions of ION and BOD terms. 

Integration of solution components 
ION transports BODs from Infor LN to Infor Business Vault, no BODs are transported from Infor 

Business Vault to Infor LN. The Business Vault extracts data from BODs to fill the base data store 

(BDS) for use by Infor LN Analytics Foundation. 

See the appropriate configuration guide for ION for the complete list of BODs available for each 

product and for a list of the events that generate each BOD. 
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Data mapping 
 

Use the Infor LN to Infor BDS Cross BOD Mapping and Descriptions guide if you need to determine 

the source location and target location of the integrated data, and which conversions, if any, are 

performed between the source and target. 
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ION transports BODs from Infor LN to Infor Business Vault. The Business Vault extracts data from 

BODs to fill the base data store (BDS) for use by Infor LN Analytics Foundation. 

LN 
In Infor LN you must complete configuration tasks as described in the Infor LN Configuration Guide 

for Infor ION. 

Integration to Analytics Foundation specifically requires to setup account mappings to taxonomies 

(US GAAP, IFRS or HBG). Account mappings are to be configured in hierarchies in Business Vault. 

Note: In LN 10.5 taxonomy functionality has been added that allows to map accounts in LN. In future 

this mapping will be published as part of the ChartOfAccounts BOD, stored in BDS and read by 

hierarchies in Business Vault, such that configuration in Business Vault is not required anymore. 

ION 
In ION, setup routing from LN (send from application) to Business Vault (receive in application) for 

the following BODs: 

1. AccountingEntity 

2. AccountingChart  

3. CodeDefinition 

4. ChartOfAccounts 

5. CustomerPartyMaster  

6. CustomerReturn  

7. FinancialCalendar 

8. Invoice  
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9. ItemMaster  

10. LnVendorRating (ensure to register the LN specific BODs as standard BOD in IONs registry) 

11. Location  

12. Person 

13. ProductionOrder  

14. ProjectMaster 

15. PurchaseOrder 

16. SalesOrder  

17. SupplierPartyMaster  

18. ShipFromPartyMaster  

19. SourceSystemGLMovement 

Business Vault 

In Infor Business Vault you must complete configuration tasks as described in the Infor LN 

Integration Guide for Infor ION Business Vault. 

1. On the server where Business Vault is installed, register the LN specific BODs in the 

dedicated noun drop folder of Business Vault, specifically the LnVendorRating BOD is used 

in Analytics Foundation. 

2. In SQL server studio, run the SQL queries to create the tables in the database as specified in 

the database connection. 

3. In Business Vault Desk, create a data store for the LN specific BODs, for example called 

‘LN_BDS’ and point to the same database connection as used for the data store for the 

standard business vault data store. 

4. In Business Vault Desk, import the BOD Mappings (shredder definitions) in the LN data store 

and activate. 

Infor Analytics Foundation 
In Infor Analytics Foundation you must complete configuration tasks as described in the Infor LN 

Infor Analytics Installation Guide.. 
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After the ION connections are configured, BODs must be published for this integration.  

Starting products and services 
Start these products, services and processes if they are not already running:  

 Infor LN 

 Business Vault services 

 ION Service. Use the ION Grid Management user interface to verify that the ION Service is 

running. See the Infor ION Connect Administration Guide.  

 Analytics 

Initial data load 
During normal processing, BODs are generated when a user makes a data change or completes a 

transaction. However, when you set up a new integration with Business Vault, you must manually 

generate BODs that pass the current set of Infor LN data to Business Vault, so that the base 

systems are synchronized. The BODs are placed in the message outbox, from which Infor ION 

retrieves them and passes them to Business Vault. 

Document ‘Domain Descriptions Infor Business Analytics’ describes in detail the BODs that are used 

per domain. Note that some of the code lists are prepackaged with the Business Vault product. 

This document describes how to publish the required BODs from LN: 

Publishing existing master data 

To publish the existing master data to Business Vault.  
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To ensure that other connection points are not be disturbed by the initial load of Business Vault, on 

the Options tab of the initial load sessions, select Use Show Verb and specify the logical ID of the 

Business Vault connection point in the Logical ID field. 

 

Select the Publish Logistic Master Data (tcbod0200m000) session.  

1 On the PartyMaster tab, select the Sold-to, Buy-from, and Ship-from roles. 

2 On the ItemMaster tab, select Items and Revisions for publishing.  

3 On the Location tab, select all location types. 

4 On the Person tab, select the employees. 

5 On the Project tab, select the manufacturing (PCS) projects. 

 

Select the Publish Logistic Code Definitions A-L (tcbod0200m100) session. 

6 Customer Types 

7 Departments 

8 Industries 

9 Item Classes 

10 Item Groups 

 

Select the Publish Logistic Code Definitions M-Z (tcbod0200m200) sessions. 

11 Markets 

12 Product Lines 

13 Territories 

14 Unit Codes 

15 System Defined List IDs (Item Types, MRO Classes, etc) 

 

Select the Publish Financial Master Data (tfbia0200m000) session. 

16 On the AccountingEntity tab, select the AccountingEntity. 

17 On the CodeDefinition I, II, III tabs select all check boxes. 

18 On the Charts tab, select the AccountingChart and ChartOfAccounts 

19 On the FinancialCalendar tab, select the FinancialCalendar. 

 

Select the Publish Project Data (tpbod0200m000) session. 

20 On the Project tab, select the (TP) projects. 
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Publishing transactional BODs  

To publish procurement, sales, production and finance bods: 

 

Select the Publish Order Management Transactional Data (tdbod0200m000) session. 

1 On the PurchaseOrder tab, select the purchase orders. 

2 On the SalesOrder tab, select the sales order. 

3 On the CustomerReturn tab, select the customer returns (sales orders with negative quantity). 

4 On the LnVendorRating tab, select the vendor ratings. 

 

Select the Publish Manufacturing Transactional Data (tibod0200m000) session. 

5 On the ProductionOrder I and II tab, select the shop floor production orders and assembly 

orders. 

 

Select the Publish Financial Transactional Data (tfbia0210m000) session. 

6 On the Invoice tab, select the invoice from central invoicing and accounts receivable (invoices 

are used for sales domain in analytics foundation) 

 

Select the Publish General Ledger Movement (tfbia8205m000) session. 

7 On the SourceSystemGLMovement tab, select Opening, Actual and Budget. 

Publishing any additional initialization data 
All master and initializing data is included in the initial loads from Infor LN. Additional master data 

BODs and transaction BODs are generated through Infor LN business events as they occur. 

For a list of the events that generate BODs, see “Business events that generate outbound BODs” in 

the Infor LN Configuration Guide for Infor ION. 
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